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Overview

This document serves as a User Guide for the OAISYS recording solutions;
Tracer and Talkument, version 6. The features described in this document apply
to Knowledge Workers, Call Agents, and Call Managers.

The following features are Tracer only features and are not available with
Talkument:

Reports

Evaluations (including Live Evaluations)
Work Queues

Coaching

Live Calls

Tracer is OAISYS’ professional interaction management solution. Designed to
enable businesses to harness complete knowledge of their operations, Tracer
digitally records telephone conversations, enables live call monitoring, lets
managers rate performance, generates reports, plays back calls, searches
records and much more, all through a highly intuitive user interface.

Tracer lets call centers target those conversations that have a lasting impact on
their business. With a variety of audio connections, telephone system
integrations and recording triggers, Tracer automatically records, stores and
organizes telephone conversations in a secure central server. Among the
benefits Tracer brings to call centers are:

Ease of Training: Use agents’ actual calls to highlight their strengths and
weaknesses, improving their performance through real-world examples.

Live Call Monitoring: Listen to calls as they happen and coach agents in real-time
through instant messaging, reducing the need for follow-up later.

Liability Protection: Keeping recorded archives of calls eliminates “he said/she
said” and puts your business in the driver’s seat when it comes to compliance
issues or dispute resolution.

Activity Reporting: Tracer’s reporting and scoring capabilities quantifiably tell you
who your star performers are, and who needs extra help in realizing their
potential.

Security: Users can only access the calls they are assigned permission for.
Digital watermarking ensures recordings are not altered.
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Search capability: Calls are easily found using any number of search criteria,
including: telephone number, account codes, date or time of call and any
customized field tags you may create, such as, “Abusive Caller” or “Agree to

Pay.”

Tracer is the ideal call center recording and quality assurance solution for small-
to-medium-sized call centers, since it was created with their specific needs in

mind.
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OAISYS Client PC Requirements

The OAISYS Client PCs must meet the following requirements:

Minimum

Recommended

Operating System

Win2000 Pro /
Server SP4, WinXP
Pro

XP SP2 or Vista

Processor Celeron or Pentium
4.2.0 GHz+
Memory 512 MB 1+ GB
Hard Drive 20 GB
Optical Drive CD-RW
Video XGA (1024 x 768 or | 128+MB Video

higher)
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Organize: The Folder View

The Folder View consists of Call Folders, Call Search Folders and Shared
Folders.

A plus sign indicates the folder can be expanded to display the folders under the
Call Folders, Search Folders or Shared Folders.

= by Folders
_"-". Calls Shared To Me [1]
) Report Drill-Diown
) My Call:
3 Al Callz | Can View
Call Folders
= Call Search Folders
- Work Queue Folders
) Folders Shared To Me

By default, each user will have a set of “My Folders” or Personal Folders. These
folders consist of Calls Shared To Me or an Inbox, My Calls, All Calls | Can View,
Call Folders, Call Search Folders, and Shared Folders.

To change the folder display go to View > Show/Hide Folders.
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Calls Shared To Me (Inbox)

The inbox is a default folder that appears in every user’s application. The inbox
is populated with calls that have been distributed to the user. You can not drag

and drop calls to this folder from another folder however; you can drag and drop
documents from your inbox to another folder. The inbox is a static folder. This

means it does not have a search criteria associated with it.

Calls | Shared

The Calls | Shared folder is not displayed by default. The Calls | Shared folder is
populated with calls that the user has shared with one or more users or user
groups. You can not drag and drop calls to this folder from another folder
however; you can drag and drop calls from your Calls | Shared folder to another
folder. The Calls | Shared folder is a dynamic folder. This means it has a search
criteria associated with it.

My Calls

This default folder appears in every user’s application. This folder is populated
with calls that have call data such as extension or agent ID associated with the
user. This is a dynamic folder. This means it has a search criteria associated
with it. The search criteria for the My Calls folder is the user’s extension or agent
ID. This search criterion can not be changed. You can not drag and drop a call
from another folder into you're My Calls folder. You can drag a call from your My
Calls into one of your static folders. The call will remain in your My Calls folder
as well as the folder you placed it in.
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All Calls | Can View

This is a default folder that appears in every user’s application interface. This
folder is populated with all calls the user has permission to. This is a dynamic
folder. You can not drag and drop calls into your All Calls folder. You can drag
and drop calls from your All Calls folder into one of your static folders. The call
will remain in the All Calls folder as well as the folder you placed it in.

Call Folders

By default every user will have Call Folders in their application. Call folders are
user created folders. They are static folders. The user can add and remove calls
from any other folder and put them in a call folder.

To create a new call folder: Highlight <Call Folders>, right click and select New
Folder.

A folder will appear under your Calls Folder called New Folder. Name your new

folder and click away. Your new folder will appear with its new name in
alphabetical order under your Calls Folders.
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Search Folders

Users will be allowed or denied the ability to create search folders based on their
permissions set by the Administrator. A search folder is a dynamic folder. This
means that each time you select the folder it will ‘search’ for calls that meet the
criteria or condition that you have set for that folder. You can not place calls into
a search folder by dragging and dropping them there however, you can drag and
drop calls from a search folder into one of your static personal folders. Search
folders can be distinguished from call folders by their unigue icon:

To create a new search folder: highlight <Search Folders>, right click and select
New Folder.

The following window will be displayed:
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Enter a name for your new search folder. Select Basic, Advanced, or Call Filter
from the Search Type drop down. (Please see the section on Searches for more
information.) For a basic search enter your search string. Click Okay.

Your new search folder will appear beneath your Search Folders. Each time you
select this folder a search will be performed and all the documents that meet your
criteria will appear in the folder.

Use the Refresh button to execute the search and refresh your search folder.
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Folders Shared To Me (Network Folders)

Users will be allowed or denied the ability to create Shared folders based on their
permissions set by the Administrator.

A shared folder is a folder you create that allows others to view the calls in that
folder. For example, you may have a collection of calls you’d like to share with
your sales team. You can create a folder called Sales Team and share it with
your team. Each time you have a call you'd like your sales team to review; you
just drag and drop it into the specified shared folder. Shared folders are static
folders. They are not associated with search criteria. A user must manually
place a call or documents in the folder.

To create a new Shared Folder: highlight the folder you want to share, right click
and select Share Folder.

Select the user(s) or user group(s) you want to share the folder with. The folder
will now appear as a Shared folder under the user(s) or user group(s) Shared
Folders. The user whom shared the folder will appear under the Shared Folders,
the folder they shared will appear.
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Work Queues

Description:

A work queue is intended to be used like a To Do list. The user creates a Work
Queue folder that will be randomly populated with calls the user must listen to
and evaluate. This can be a set number of calls per day or per week or a
percentage of calls that must be evaluated per day or per week. For example, “I
want to evaluate a random sample (20%) of my sales agents’ incoming calls
each week.”

What needs to be done before | create a Work Queue?

1. An Extension List or an Agent List must be set up in the Administrator.

2. A call filter must be created in the Administrator.

3. An Evaluation must be created in the Administrator. The evaluation will be
associated with either an agent list or an extension list and a call filter.

Create a new Work Queue
Right click on the Work Queue Folders
Select <New Folder> to display the following window:
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Folder Name : Enter a name for the Work Queue Folder

Evaluation Type : Select the evaluation you'd like this work queue to be
associated with from the drop down list. Note: Evaluations must be created in
the administrative application before they will appear in the drop down list.
Selection Mode : Select either Percentage of Calls or Number of Calls.
Percentage : Enter a percentage of calls you wish to evaluate.

Number : Enter the number of calls you wish to populate the work queue.
Refresh : Select Daily or Weekly. This is how often you would like your work
gueue to repopulate with fresh calls.

Checkbox: Enter a check to indicate that the agent(s) must evaluate the same
call(s). If selected, the agent will see a work queue folder in their Tracer
application. The work queue will automatically be populated with the same calls
that their manager evaluated.

Edit a Work Queue

Select the work queue, right click and choose Edit Folder.
Change any information and click Okay to save the changes.
The following warning message will appeatr:

If you click Yes the existing calls in your Work Queue will be cleared out. Your
folder will be repopulated with new calls.
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Delete a Work Queue
Select the work queue folder you want to delete. Right click and choose
<Delete>.

Using a Work Queue

Once a work queue is created it is populated with random calls the user must
evaluate. When the user highlights the work queue the first call in the work
gueue will pop up with the evaluation form and the audio will begin playback.
The user may begin evaluating the call immediately. Once the user finishes the
evaluation the call will disappear from the work queue and the next call in the list
will open to be evaluated. The user may choose to finish the evaluation later. If
the user does not complete the evaluation the call will remain in the work queue.
Once a call evaluation is finished; the next call evaluation in the list will popup.
This will occur until the user clicks off of the work queue folder.

The work queue is repopulated with random calls every 24 hours according to
the housekeeping settings.

The work queue will be randomly populated with calls the user has permissions
to.

If a call in a Work Queue has more than one evaluation associated with it the
following behavior will occur.

The evaluation for the first agent (or extension) will popup when the call is
selected. The user may choose to finish the evaluation later and select the same
call but another evaluation for the call. The call will disappear from the user’s
work queue when any one of the available evaluations is completed. If desired,
the user can find the other evaluations through a search in another folder in
Historical Calls. If a call has more than one evaluation associated with it the first
agent or extension involved in the call will be the first evaluation in the list and
thus the first evaluation to popup.
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Folder Maintenance

Each time you select a folder and right click on it you will see the following
options: New Folder, Delete, Rename, Edit Folder, Share Folder. Some of the
options may be grayed out. This means you do not have permission to the
option or that the option is not available for the selected folder.

Delete

You can not delete your Inbox, Shared Calls, My Calls, or All Calls | Can View
folders. If you have permission to delete you can delete a user created call
folder, a user created search folder or a user created share folder.

Rename

You can not rename your Inbox, Shared Calls, My Calls, or All Calls folders. If
you have permission to rename you can rename a user created call folder, a user
created search folder or a user created share folder.

Edit Folder

If you have permission to edit you can edit a user created search folder or a
network folder. You can not edit your Inbox, Shared Calls, My Calls, or All Calls |
Can View folders. You can not edit a user created call folder. By editing a
search folder you are changing the search criteria for the search folder. By
editing a share folder you are changing the share conditions of the folder.

Share Folder
You can not share your Shared Calls, My Calls, or All Calls folders. If you have
permission to share a folder you can share a user created call folder, a user
created search folder or a user created share folder.
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Annotations

Annotations are comments that are added to a call recording once a call has completed.
They are post call information to help users identify key information about calls.
Annotations have a starting point, an ending point, an author, a subject and text.
System annotations are added by the OAISYS system. These annotations provide
information such as why a call was or was not recorded. These annotations will display
with the author as ‘System’. The user can toggle the display of System Annotations by
setting the option in the Configuration option from the menu bar. Go to Configuration >
Preferences > View tab. By default, the system annotations are not displayed.

A user with permissions can annotate an entire call, or any part of a call. There are no
limitations on the number of annotations a voice document can have.

Part of the power of the OAISYS Client is the ability to search based on text entered as
an annotation.

The ability to annotate a call is permissions based. A user may have permission to Add,
Edit and or Delete annotations. By default a user will have the ability to annotate all of
the calls that appear in their My Calls folder. The ability to annotate other calls is
determined by permissions lists. (For more information on permission lists, refer to the
documentation on permissions.)
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View Annotations

You can identify whether or not a call has one or more annotations associated with it
several different ways.

1. From the Visualization window you can identify annotations by the date and time
stamp and author next to the annotation icon.

2. From the Detailed View you can identify annotations under the Annotations section.
Make sure to enter a checkmark in the box to indicate you'd like to see the
annotations displayed. The annotations appear as a yellow bar on the timeline in the
place in the call where the annotation was entered.

3. Expand the Annotations panel. Highlight an annotation on the left to see the Author,
Start Time, End Time, Subject, and Text on the left.
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Add or Insert an Annotation

Highlight a call in the call list view. The highlighted record will load in the Call
Visualization area, or double click on the highlighted call to open the Call Visualization
details.

Use the blue tracker ball to highlight an entire call or just a section of a call.

Click the Insert Annotation button as shown above. This will open the Create Annotation
box. The author will be filled out with the logged in users name. The start time and end
time will automatically be filled out according to the highlighted section of the call. Enter
a subject for the annotation. Enter text for the annotation. Click Save to save the
information. Note: You must enter either a subject or text or both. You can not leave
both the subject and the text blank.
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Another way to annotate a call is to highlight the section of the call that you want to
annotate and click Add in the Annotation section. If you do not highlight a section of a
call and you click Add then the annotation will apply to the entire call.

Edit an Annotation

Highlight the annotation you wish to edit in the Annotation pane. Click Edit. This will
open up the Edit Annotation box. Make desired changes and click Save.

Note: You can only edit an annotation if you have proper permissions. Please refer to
the section on Permissions for more information.

OAISYS Client Application User Guide
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Delete an Annotation

Highlight the annotation you wish to delete in the Annotation pane. Click Delete. A
confirmation dialog box will appear. Click Yes to confirm and No to deny the deletion.

Note: You can only delete an annotation if you have proper permissions. Please refer to
the section on Permissions for more information.

Search for an Annotation

Annotations can be searched upon based on the Subject of the annotation or the Text
within the annotation. Both Basic and Advanced searches can be performed on
annotations.

Basic Search — Enter the text string for the subject or the text within the annotation. Click
<enter> or Search.

Basic searches execute the search on all fields available. For example, if you want to
search for an annotation with a subject of Address as shown above, a basic search would
return results for all calls with Address in any field. If there were a call with the outside
name of Address for example, this too would match your Basic search criteria. For more
information on Searches, please refer to that section of the documentation.

Advanced Search — An advanced search can be done based on the criteria of either the
subject of the annotation or the text content of the annotation.
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If you select Annotation Subject or Annotation Text from the drop down you’ll have the
following condition options: Exactly Matches, Contains, Starts With, Ends With, Contains
Word, Contains Phrase, and Starts in Word.

Once you select a condition you must enter a value.

For more information on Advanced Searches refer the documentation on Searches.

Annotation View

To display the annotation view from the OAISYS client click the plus/minus sign to display
the minus sign.

Use the Expand all and Collapse all buttons to display the contents of all of the
annotations or collapse the contents. If the contents are displayed the Author, Created
date and time, Subject and the start and end times of the annotation are displayed. The
text is displayed too. If the annotations are collapsed, the contents are not displayed.

You can individually select annotation text to be displayed by clicking on the double
arrows as shown above.
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System Annotations

There is a special type of annotation called a System Annotation. These annotations can
not be edited or deleted. The Author will be displayed as ‘System’. These are
annotations added automatically by the OAISYS system to indicate such things as why a
recording was started or stopped.

You can configure the application to display the system annotations, or not.
Go to Config from the menu. Click Preferences, go to the View tab.

Call View
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The Call View is a visual representation of a call. It includes the information bar, the
playback controls, a slider and hover ball, start and end times of the call, call transitions,
extensions and outside parties involved with the call, annotations, visual indication if a
user does not have permission to certain parts of a call, and visual indication for video if
Tracer Screen Recording is being used. Each of these is explored in more detail below.
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Information Bar

The information bar displays information about the selected document or the current
document displayed in the child window.

There are three icons located on the left: Display, Rename Document, and View Details.

The Calling Number, the Date, the Start Time, and the Duration of the call is displayed in
the Information Bar.
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Display
Click the Display icon in the information bar to select the document you want displayed in

the Call View. Your options are Detailed View, Annotations, and Evaluatios. At least one
of the options must be displayed at all times.

Detailed View: If you select this option the detailed view of the call is displayed. The call
details include call transitions, outside parties, extensions, ACD Agents, ACD Groups,
Annotations, Account Codes, and Extra Info.

Annotations: If you select this option the Annotations window will be displayed. It
includes Author, Created date and time, Subject, time interval, and annotation text.

Evaluations: If you select this option any and all evaluations that are associated with the
call will display.
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Detailed View

The Detailed View section of the OAISYS application displays which sections of the call
were and were not recorded, the sections of the call that the user does and does not
have permission to listen to, the Outside Parties, extensions, ACD agents, ACD groups,
account codes, extra information, annotations, coaching conversation, and a time line for
the duration of the call. The user can select which of these options to display by clicking
on ‘Displayed Sections’ and entering a check mark next to the options they'd like
displayed.

The gray and or red bar represents the audio. The gray represents audio that was not
recorded or audio that was recorded but the user does not have permission to listen to. If
the user hovers over the gray part of the bar, the tool tip will inform the user whether or
not there is audio recorded and whether or not the user has permission to listen to the
audio. The green bar represents video. (OAISYS Screen Recording Server is required
for desktop screen recording.)

The blue hover ball can be dragged across the gray/red bar to display what happened at
that point in time. As the user moves the hover ball, the information will dynamically
change in the left panel to represent what happened at that point in time. The user can
also choose to dock the hover ball by right clicking on the hover ball and selecting <dock
hover ball>. Undock the hover ball by right clicking and selecting <dock hover ball>
again.
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Playback Controls

The playback controls are located in the Detailed View section of the client application.
The controls are used to view the entire call, zoom in on a selected part of a call, zoom
in, zoom out, insert annotations, play the recording, play the recording in high speed, stop
playback of the recording, jump to the beginning of a call recording, rewind, and fast
forward.

Clear All — Clear any selected parts of the call.

Lock — Lock the selected part of the call.

Share Segment — Share the selected or highlighted segment(s) of the call.

Entire Call — Use this option to view the entire call if you previously zoomed into the call.
Zoom Selected — Highlight part of the call and zoom in on the highlighted part.

Zoom In — Zoom into the call gradually.

Zoom Out — Zoom out gradually.

Insert Annotation — Enter an annotation. (Refer to the documentation on Annotations for
more info.)

Play — Play the recording back in normal speed.

Play High Speed — Play the recording back in fast mode.

Stop — Stop playback of the recording.

Jump to Beginning — Go back to the beginning of the recording.
Rewind — Rewind playback approximately 12 seconds.

Fast Forward — Fast forward playback approximately 12 seconds.

Skip Held Sections — Automatically skips playback over any places where the call was
placed on hold.

Volume — Adjust the playback volume.
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Call Details

The Call Details section of the client application displays the Outside Parties, extensions,
ACD agents, ACD groups, account codes, extra information, and annotations. The user
can select which of these options to display by clicking on ‘Displayed Sections’ and
entering a check mark next to the options they'd like displayed.

The user can further control what is and is not displayed by entering a checkmark in the
individual boxes for the different options. For example, if the user does not want to see
where extension 1009 is involved in the call below, they simply uncheck the box and the
bar next to x1009 will disappear.

Call transitions are represented by different colors. Each call state and duration of that
state is displayed as a color coded bar. Annotations are represented by a color bar for
the duration of the annotation and at the point in the timeline where the annotation was
entered.

Account codes and extra info are displayed with markers below the color coded bars.
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Annotations

The Annotation section can be used to View, Add, Edit, and Delete annotations.
Please refer to the section on Annotations for more information.

Evaluations

The Evaluation section is used to perform evaluations. The user with permission can
email the evaluations and share the call.
Evaluations can be performed live, via the Live Calls, or on historical calls.

A call can have zero, one, or more evaluations associated with it. The user will highlight a call in
the call list view. If the highlighted call has an evaluation associated with it the evaluation will
appear under the evaluation summary section.

Highlight the evaluation and click on the Evaluate button. An evaluation form will open up as
shown below.

Score the evaluation by choosing the appropriate score or yes/no answer from the drop down
box.

There is room below the questions to add notes and comments.

Use the Finish, Finish Later, or Cancel buttons at the top of the evaluation questions to indicate
the status of the evaluation.
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Email an evaluation to someone once the evaluation is complete. Click the email button as
shown below. This will display the Create and Manage Share box. Email to an external user or
share with another OAISYS client user.
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Perform a Live Evaluation following the same steps from the Live Calls application.

OAISYS Client Application User Guide

32



Call List View

The call list view consists of a listing of all calls in a selected folder. Calls can be
read or unread. An unread call is displayed in bold text. You can also
distinguish a read call from an unread call by the icon that appears in the first
column of the call list view. The read icon looks like an opened envelope while
the unread call icon looks like a closed envelope.

Note: Some columns in the Call List view are editable while some are not.
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Sort

Columns can be sorted upon by clicking on the column header. There are up to
four sort orders. After clicking on the first column a number one will appear in
that column. Hold the Control button down and select the second column you'd
like to sort by.

Customize

Information about calls appears in a table form that consists of rows and
columns. Each row represents an individual call. Each column represents
information about the calls. The order in which the columns appear can be
customized by dragging and dropping the column.

The columns you display in your document list view are customizable per user.
Click on View from the menu then Field Chooser. Drag the fields you'd like
displayed into the Call List View.

The available Field columns are:

Call-Record ID — ID Number of the Call Record

Start Date/Time — Date and Time the call started

Duration — The length of time the call lasted from start to finish.
Outside Name — name of the outside caller for inbound calls if available
Account Code — account code entered during call if applicable
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Outside Number — number of caller for inbound/outbound calls if available
Call Direction — direction of call, either inbound or outbound

ACD Agent — ACD Agent associated with the call

ACD Group — ACD Group associated with the call

DNIS/DID — DNIS or DID if available

Subject — extra info added to call by another OAISYS application

Ref ID — document reference identification number

Start Time — Start time of the call only (does not include date)

Area Code — area code of the inbound or outbound call if available

PVD Pathname — location where the pvd is stored

Save Until — date document is tagged as being saved until (default is
blank)

Call Recorded — Yes/No indicates whether or not the call was recorded.
Call Answered — Yes/No indicates whether or not the call was answered.

**Note: If there are multiple values associated with a column the last value
entered will be displayed. For example, if there is more than one account code
entered during a call, the last account code that was entered will display in the
Account Code column.
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Remove from this folder

(You must have permission to do this.)

When you remove a call from a folder, you do not delete the call recording. You
simply remove the reference to the call from the selected folder. You can not
remove calls from the Shared Calls, My Calls, All Calls, or any of Search folders.

Select a call, right click and select <Remove from this Folder>. A confirmation
dialog box will appear.

Delete permanently

(You must have permission to do this.) When you delete a call you delete all
references to that call permanently. To delete a call select a call, right click and
select <Delete Permanently>. A confirmation dialog box will appear. You can
delete a call from any folder if you have permission to do so.
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Set Expiration

(You must have permission to do this.) You can set the expiration date of a call
located in any folder. To set the expiration date of the call: highlight the call, right
click and select <Set Expiration Date

Select a date for the call to expire. You can click on the drop down to bring up a
calendar.

Share

(You must have permission to do this.) You can share a call located in any
folder. To share the call: highlight the call, right click and select <Sharing>, then
<Create and Manage Shares>. The Share Documents window will appear.

Select one or more users/user groups/external users to share the selected call
with and use the arrow to move them to the Share with box. The user class is
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displayed next to the name. User represents a User with a Client account. A
user group represents a group of users set up in the Administrative client
application. An external user is someone outside of the regular business that
has a temporary user account. An external user must have an email account
associated with their name. An external user must have an expiration date
associated with their user account.

Add a new external user: To add an external user not displayed in the list of

names click on <New>. Enter the name, email address, and the date you would
like the account to expire on. The default is 3 days.
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Sharing options
This Share will expire on: Enter a checkmark to indicate you'd like
to specify an expiration date. Enter a date or click on the dropdown
to display a calendar. This is the date the selected user or user
group can access the call(s) through. If a user tries to
access a document beyond the expiration date they will receive an
expiration notice and they will not have access to the call(s).

Allow internal user(s) to further share the call(s): Enter a
checkmark to indicate whether or not you'd like to allow the
recipient(s) of the shared call(s) to share the call(s)

with someone else. Note: If the recipient of the shared

call(s) is allowed to further share the call(s) the next

recipient will be limited to the permissions of the original sender.
For example, if you share a call that consists of a phone call

that involved both you and the president of your company, but you
only have permission to listen to the segment of the call that
involves you, when you share the call the recipient and

anyone whom they share it with will be limited to the segment of the
call that involves you.

Allow the recipient(s) to create, change, and delete their own
annotations, based on your permissions: Enter a checkmark to
indicate whether or not you'd like to allow the recipient(s) to be
allowed to use the annotation feature to create, edit,

or delete annotations. This refers to their annotations. They can
not edit or delete annotations that already exist in the call(s).

Click Okay to complete the sharing of the call(s).
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Export Selected Calls(s) to CSV File
Select one or more call recoardings in the list. Right click and select <Export

selected calls to CSV File>
This .csv file will contain all of the call data.

Export Entire Grid to CSV File
Select any call in any folder, right click and select <export entire grid to CSV file.
This will export all calls in the highlighted folder to a single .csv file.
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Export Audio to Disk

(You must have permission to do this.) Select a call in the list view. Right click
and select <Export Audio to Disk>. Browse to the location you'd like to export
the audio to. Select a format from the drop down.

Check the box to indicate whether or not you’'d like to email the file after it has
converted. If you check this box an email window will pop up after the file has
been converted. You can type in one or more recipients email address and the
file will show attached.

Verify Signatures

The OAISYS system applies a digital signature to each and every call recording.
The purpose of this digital signature is to validate the integrity of the recordings.
This tool is used to check to see if the digital signature is in tact. If a recording
were altered in some way the integrity check would fail.

To use this tool highlight a call(s) in any folder. Right click and select <Verify
Signatures>
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Receiving a Shared Call

Internal Users:

Once a call recording has been shared with you by a user the call(s) will appear
in your Calls Shared To Me folder, or Inbox. The number in parenthesis shows
how many new calls you have in your Inbox.

If the Management Studio is minimized and you receive a new call in your Calls
Shared To Me folder you will receive a visual notification. A pop up will tell you
that you received a new call and an icon will appear in your tray.

You can sort upon Shared calls. There are column headers to indicate whether
or not a call is shared and if so, who it is from, the date the share expires, and
whether or not the recipient is allowed to create, edit, or delete annotations.

External Users:

Once a call has been shared with a recipient by a user the recipient will receive
an email notification that includes a link to the call recording. If the recipient has
loaded the OAISYS client previously, the client will launch upon clicking the link
and the distributed call will be selected and available for the user to play and
view the information they have permissions to. If the recipient has not loaded the
client before, they’ll be prompted to do so. By default the temporary account
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should be valid for 3 days. The distributor of the call recording can set this to
another value.
Note: The recipient must have .NET 3.5 SP1 installed on their PC.
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Sharing a Folder

Select the folder you wish to share from the Folder view.
Right click on the folder and select Share Folder.
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This will bring up the Share Folders window.

Select the user(s) or user group(s) you want to share the folder with by entering a
checkmark next to their name.

If you wish to share with an external user who is not listed and you have
permission to add external users, click the New button and add their
name, Email Address, and expiration date for their temporary account.

Sharing Options:
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Select the date the shared folder will expire on or click on the drop down to pick a
date from the calendar.

Allow Document Remove — By checking this box you allow the user(s) or user
group(s) you are sharing the folder with to remove calls from the shared folder.

Allow Document Delete — By checking this box you allow the user(s) or user
group(s) you are sharing the folder with to permanently delete calls from this
folder. Once deleted, the call is gone.

Allow Document Add — By checking this box you allow the user(s) or user
group(s) you are sharing the folder with to add calls to this folder.

Allow Annotation Modification — By checking this box you allow the user(s) or

user group(s) you are sharing the folder with to modify annotations.

Note: Shared folders can not be further shared by a recipient of a shared folder.
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Find/Searching

There are two types of searches available within the OAISYS Management
Studio; Basic and Advanced. Each is available from the call list section of the
application.

Basic Search

The basic search allows the user to enter a text string to search upon. The user
can enter text consisting of letters, numbers, or characters and the application
will search all fields for the text string entered by the user.

The basic search is located on the bar at the upper right hand corner of the Call
List View next to the call count.

To perform a Basic Search click on the Find button. Then highlight the call folder
you want to search. Enter the information you want to be found and click the
Search button as shown below or click enter on your keyboard.

The OAISYS Management Studio will begin searching all of the calls in the
highlighted folder for the information you entered. While the search is performed
you will see a green bar indicating the search is in progress.
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Once the search is completed the number of calls that meet the search criteria
will be displayed next to the Search.

Click Clear to Clear the search results in the selected folder.

Keep in mind that for a basic search all fields are searched and this may take
awhile if there are many calls in the selected folder. For example, let's say you'd
like to find all of the calls that came from area code 440 in your ‘My Calls’ folder.
You enter 440 as your search criteria and click <enter>. The client application
will return calls that have any instance of 440. You will get results of calls from
area code 440, or calls to 714-440-2121, or calls with an account code of 4404,
or a call that has an annotation that includes 440 in the annotation, etc.

Basic Search — Below are all of the search fields used for the basic search.

Start Date

Start Time

Outside Number
Duration

Call Direction

Subject

DNIS/DID

DNIS Description
Account Code

Account Code Description
Outside Name

Area Code (North America only)
Agent ID

Agent ID Description
Extension

Extension Name

ACD Group

ACD Group Description
Extra Call Info
Annotation Content
Annotation Date
Annotation Author
Annotation Subject

Advanced Search

The advanced search allows the user to select a specific field to search and a
value for the field. Advanced searches are most useful when you know exactly
what you are looking for.
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The advanced search is located on the bar at the top of the Call List View.

To perform an Advanced Search highlight the call folder you want to search from
the folder view on the left. Click Adv. Find

Select a field from the drop down box. Once the field is selected a condition
control will be enabled. The condition control will be populated with conditions
that are appropriate for the selected field. If appropriate, the value control will
become enabled. Enter a value to search upon.

The advanced search will allow you to enter as many criteria to a search list as
you want to. Use the And/Or toggle to change the search from an ‘and’
statement to an ‘or’ statement. Use the up and down arrows to move the search
elements up and down to support grouped element searches.

Finally, click Execute Search to begin the Advanced Search.

While the search is performed you will see a green bar indicating the search is in
progress.

Once the search is completed the number of calls that meet the search criteria
will be displayed next to the Search.

Click Clear to Clear the search results in the selected folder.

Close the Advanced Search dialog box by clicking on the X in the upper right
corner.
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Work Queues

Description:

A work queue is intended to be used like a To Do list. The user creates a Work
Queue folder that will be randomly populated with calls the user must listen to
and evaluate. This can be a set number of calls per day or per week or a
percentage of calls that must be evaluated per day or per week. For example, “I
want to evaluate a random sample (20%) of my sales agents’ incoming calls
each week.”

What needs to be done before | create a Work Queue?

4. An Extension List or an Agent List must be set up in the Administrator.

5. A call filter must be created in the Administrator.

6. An Evaluation must be created in the Administrator. The evaluation will be
associated with either an agent list or an extension list and a call filter.

Create a new Work Queue
Right click on the Work Queue Folders
Select <New Folder> to display the following window:
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Folder Name : Enter a name for the Work Queue Folder

Evaluation Type : Select the evaluation you'd like this work queue to be
associated with from the drop down list. Note: Evaluations must be created in
the administrative application before they will appear in the drop down list.
Selection Mode : Select either Percentage of Calls or Number of Calls.
Percentage : Enter a percentage of calls you wish to evaluate.

Number : Enter the number of calls you wish to populate the work queue.
Refresh : Select Daily or Weekly. This is how often you would like your work
gueue to repopulate with fresh calls.

Checkbox: Enter a check to indicate that the agent(s) must evaluate the same
call(s). If selected, the agent will see a work queue folder in their Tracer
application. The work queue will automatically be populated with the same calls
that their manager evaluated.

Edit a Work Queue

Select the work queue, right click and choose Edit Folder.
Change any information and click Okay to save the changes.
The following warning message will appeatr:

If you click Yes the existing calls in your Work Queue will be cleared out. Your
folder will be repopulated with new calls.
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Delete a Work Queue
Select the work queue folder you want to delete. Right click and choose
<Delete>.

Using a Work Queue

Once a work queue is created it is populated with random calls the user must
evaluate. When the user highlights the work queue the first call in the work
gueue will pop up with the evaluation form and the audio will begin playback.
The user may begin evaluating the call immediately. Once the user finishes the
evaluation the call will disappear from the work queue and the next call in the list
will open to be evaluated. The user may choose to finish the evaluation later. If
the user does not complete the evaluation the call will remain in the work queue.
Once a call evaluation is finished; the next call evaluation in the list will popup.
This will occur until the user clicks off of the work queue folder.

The work queue is repopulated with random calls every 24 hours according to
the housekeeping settings.

The work queue will be randomly populated with calls the user has permissions
to.

If a call in a Work Queue has more than one evaluation associated with it the
following behavior will occur.

The evaluation for the first agent (or extension) will popup when the call is
selected. The user may choose to finish the evaluation later and select the same
call but another evaluation for the call. The call will disappear from the user’s
work queue when any one of the available evaluations is completed. If desired,
the user can find the other evaluations through a search in another folder in
Historical Calls. If a call has more than one evaluation associated with it the first
agent or extension involved in the call will be the first evaluation in the list and
thus the first evaluation to popup.
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Live Calls

Description

The Live Calls application is used to monitor or listen live to calls as they take
place. This application is permissions based. A user must be a user type of Call
Manager in order to have permission to the Live Calls application. A user may
have permission to all calls on their phone system or only calls that meet a
criteria determined by the administrator. In addition to listening live to a call a
user can stop and start call recordings, add a piece of information to a call, add
an annotation to a call, evaluate an agent’s performance, or coach an agent; all
from the Live Calls interface.

The Folder View within Live Calls

Live Calls are very similar to Historical Calls. The interface consists of a folder
view, a call view, call details, annotations, and evaluations.

The folders are:
All Calls — this folder contains a list of all calls the user has permission to see that

are currently taking place on the phone system or systems. **Calls can be live
monitored across more than one Tracer system.
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Calls by User — this is a customized folder or folders that can be used to monitor
live calls by a specific Tracer User. For example, a Call Manager has many calls
in their All Calls folder and they are primarily interested in listening or monitoring
calls to a new employee. They can set up a Calls by User folder.

Calls by Category — this is a customized folder or folders that can be used to
monitor live calls by any number of criteria. This is set up similar to a search
folder. For example, maybe a Call Manager must watch for calls from a certain
area code. Maybe a Call Manager wants to be aware of outbound calls to a
group of employees that exceed ten minutes. Calls by Category folders can be
used to accomplish this.

Create a New Folder

Select Calls by User or Calls by Category and right click. Choose New Folder.

The following window will display.
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Enter a name for your folder.

Select the Search Type; Basic, Advanced, or Call Filter.

Enter your search criteria and click Okay.

Your newly created folder will appear as a subfolder in your Live Calls folder
view.

When you highlight the folder all calls that meet the criteria will display.

Go to View > Field Chooser to select the fields you would like to display in the
Call Grid. Drag and drop the fields.

Listen Live
Double click on a call in the call grid to open a child window. Click the Listen Live

button to immediately begin playing the call over your PC speakers. (Please
note you can Listen Live from the parent window also.)
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Screen Recording -- Option

OAISYS Screen Recording is an optional companion product to Tracer. If a
screen recording, or video is present for a call recording the user will see a green
bar above the red bar in the visualization pane. The red bar represents audio
and the green bar represents video. (There will never be video without audio,
however there may be audio without video.)

The user must first select the Play button to begin playback of the audio. The
user can then select the Show button to begin playback of the video.
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Desktop Requirements for Screen Recording
2.5GHz processor
1GB of RAM
We don't have a minimum recommendation for a video card. We

have never seen issues with Screen Recording Client limited
because of a specific video card.
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Known Issues

There is a known issue regarding the call park and retrieve feature for use with the OAISYS
recorder and the Mitel 3300 ICP version 9.0.

If a call is manually parked on an extension the first leg of the call will not be available to the end
user for 6 hours when it is a trunk call or until another call is presented or initiated when an
internal caller is the party that is being parked.

To avoid this behavior it is suggested the end user use a pre-programmed feature soft key on the
device parking the call to evoke the call park element of this feature. If the soft key feature is
used the first leg of the call will be available once the call has completed.

OAISYS Client Application User Guide 59



